Bonus Chapter 2: Finding What's
New in Service Pack 2

In This Chapter

1 Connecting with Document Connection

v Editing Path Animations in PowerPoint

So what is Service Pack 2, or SP2? It’s the name of an automatic update
that is applied to your copy of Microsoft Office 2008 — although you
can opt to decline any such automatic updates! SP2 was released as this
book was going to the press. We won’t get into specific settings here, but
being the good souls that we are, we decided to give you an extra bonus
chapter to explain the niceties peppered throughout Office 2008 once you
have SP2 applied to your installation!

In a very unusual move, Microsoft included two major new features for
Office 2008 in its SP2 update. In the past, except for Entourage, major new
features have been included in major updates that you have to pay for. This
time, owners of Office for Mac get at no additional cost two new major
features, which are explained in this bonus chapter. The first new feature

is a new application called Document Connection that lets you share Word
documents, Excel spreadsheets, and PowerPoint presentations.

The second major feature introduced by SP2 is that PowerPoint gains the
ability to create, edit and delete motion paths. A motion path is a path
represented by a line. Objects, such as pictures or shapes, can follow the
line as they travel on a slide.

The new Microsoft Document Connection is version 12.2.0 (it is the first
version of Document Connection), We used Mozilla Firefox version 3.5.1
and the beta version of Microsoft Office Live Workspace Web-based file
hosting and sharing service when building this chapter. We have installed
the Microsoft Silverlight version 3 Web browser plug-in. If your setup is
different, you may experience differences between what you see on your
own computer and what is in this online chapter.
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Document Connection is a completely new feature that uses two special file
systems designed for sharing documents: Microsoft Office Live Workspace
and Microsoft SharePoint.

4+ Microsoft Office Live Workspace: Office Live Workspace is a Web site
that can be used to store and share files. Everyone with an Internet
connection and a Windows Live, Office Live Workspace, or Hotmail
account can use this service. Your Office Live Workspace can store and
share up to 5GB (gigabytes) worth of files.

4+ Microsoft Sharepoint: Microsoft Office SharePoint is a server product
for Microsoft Windows providing content management facilitation of
shared documents. The minimum SharePoint server requirements are
Windows SharePoint Services 3.0 and MOSS 2007 enabled servers.

On your Mac, Document Connection requires Microsoft Office 2008 with
SP2 installed. When used with the Home and Student version of Office 2008,
Document Connection works with Office Live Workspace, but you can’t
connect to a SharePoint server.

Setting things up
To use Document Connection, you need to set up an account. We describe
two account types here: Office Live Workspace and SharePoint.

Preparing to use a Office Live Workspace

Before you can begin using Document Connection with a Windows Live
Workspace, you will have to establish a Windows Live account. (You need
the username and password from your Windows Live account when you set
up Document Connection.)

A Windows Live account also doubles as your Office Live Workspace
account, your MSN Messenger account, your Hotmail account, your Mesh.
com account, and your Xbox Live account. If you already have a username
and password for any of these services, you don’t need to create a new one
to use Document Connection and you can turn to the upcoming section
“Launching Document Connection.” In this chapter, we simply refer to this
as a Windows Live account.

In Bonus Chapter 1 we describe how to sign into Office Live Workspace
using a Web browser by going to this URL (now you can use Safari 4 or
FireFox 3.5 Web browsers):

http://workspace.office.live.com
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Cloud computing is an expression sometimes can have access to Microsoft's hosted cloud
applied to an arrangement where an off-site  services. If you are using SharePoint, your
third party hosts files or computing services.  SharePoint server is hosted by a third party
The off-site servers are referred to as the off-site. (If your SharePoint server is hosted by
cloud. If you use an Office Live Workspace, you  your organization, that's not cloud computing.)

Computing in “the cloud”
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The Web site works faster when you have Silverlight version 3 installed, but
Silverlight is not required.

To create a new Windows Live username and password:

1. In Safari 4 or FireFox 3.5, visit the Office Live Workspace Web site at

this URL:
http://workspace.office.live.com/

The Office Live sign-in page displays.

. Click the Sign Up button.

The first page of the Office Live Workspace sign-up process displays.

. Enter your e-mail address, and then click the Next button.

The Create Your Account page displays, unless the e-mail address you
entered is already being used, in which case you will be prompted to
sign in.

. Fill in the requested information and then click the Finish button.

This creates your Office Live Workspace account and sends a confirmation
message to your e-mail address.

. When you receive the confirmation message in your e-mail account,

follow the instructions to click the link and activate your account.

You can now use your Office Live Workspace.

Your Office Live Workspace account automatically gives you a free Hotmail
account. Plus you can use your Office Live Workspace account to access
other Windows Live services.

Preparing to use a SharePoint site

Usually your Information Technology (IT) department takes care of setting
up a SharePoint server. If your organization uses SharePoint, request the
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Web address of the server from your IT department. Your IT department
will have to create an account for you on the SharePoint server before you
can use Document Connection with SharePoint. You will need to obtain your
SharePoint username, password and Web URL from your IT department.

Working with your Web browser

Document Connection works in tandem with your Web browser and the
Office Live Workspace Web site or SharePoint site. You will need to use your
Web browser to do the following:

4+ Create a Windows Live account (if you don’t already have one).

4+ Manage who can share your files in your Office Live Workspace or
SharePoint site. (See “Sharing Workspaces” later in this chapter.)

4+ Delete files. (See “Deleting Files” later in this chapter.)

Launching Document Connection

The first time you use Document Connection you start it from within Word,
Excel, or PowerPoint. We’ll show you how to add Document Connection to
the Dock so you can launch Document Connection from the Dock.

To start Document Connection within Word, Excel or PowerPoint use
File2>Open from Document Connection. The Document Connection applica-
tion will display. (See Figure 2-1.)

Adding Document Connection to the Dock

You can add Document Connection to the dock so that you can open
Document Connection by clicking its dock icon. To add Document
Connection to your Dock:

1. Open Document Connection from within Word, Excel, or PowerPoint
as described in the previous section.

2. Hold the mouse button down on the Document Connection icon in the
Dock.

A pop-up menu appears. See Figure 2-2.
3. From the pop-up menu choose Keep in Dock.
The Document Connection icon will stay in your Dock even after you

quit Document Connection.

You can drag the Document Connection icon to a position in your Dock so it
can be with your Office program icons.
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Add Location

Drafts New File  Edit Upload ChecklIn  Spotlight Search
Files Refresh | Add File | Read |Check Out | Discard
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Figure 2-2: Open at Login
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Adding Hide
Document Quit
. —
Connection N
to your
Dock. <
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To launch Document Connection from its Dock icon, click the icon.

Adding a location to Document Connection

To work with folders and files on a SharePoint server or Office Live
Workspace, you must first tell Document Connection which server locations
you wish to access. The locations you add will be listed in the Navigation
pane at the left of Document Connection.

Bonus

(x]
=
)
=
=3
@
-
N

2)19ed 391n1ag Ul
Map s Jeyp Buipuiy



BC12 Sharing with Document Connection

To add an Office Live Workspace connection:

1. Open Document Connection.

Use File=>Open from Document Connection or click the Document
Connection Dock icon if you followed the steps in the previous section.

_ 2. Click the Add Location button or the Add Location + sign to display a
Add Location pop‘“p menu.

3. From the pop-up menu, choose Sign into an Office Live Workspace.

An input form appears, as shown in Figure 2-3.

00 Document Connection
& sy Alee Tl m Y e
Add Location Refresh  New File Add File Egit Read Uo'cad Cheek Out  Check In Discard Filter
FILES |
| Drafts A Authentication is required to connect to Office Live Workspace v
& Favorite Files
SHAREPOINT
WORKSPACES Windows Live ID
L
F_ 2 3 Password
igure £-9:
gure ("1 Save password in my Mac 0S Keychain
Adding a -
. g . _ Cancel
Office Live
Workspace
location.
+~ = ll

4. In the Windows Live ID text box, enter your Windows Live username.
5. In the Password text box, enter your Windows Live password.
6. (Optional) Save your password in Mac OS Keychain.

Click the Save Password in My Mac OS Keychain checkbox if you want
your Mac to remember your login information so you have to enter your
username and password each time you connect to this server.

7. Click the Connect button.
Document Connection displays the folders that are available in your
Windows Live Workspace.

To add a SharePoint Server connection:

1. Open Document Connection.

Use File>Open from Document Connection or click the Document
Connection Dock icon if you followed the steps in the previous section.

2. Click the Add Location button or the Add Location + sign to display a
pop-up menu.
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FILES
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i Y SharePoint site.
W ravorite
SHAREPOINT
WORKSPACES
Figure 2-4: 2 workspaq Address: | http://
Addlng a Authentication: | Username and password o
WlndOWS User name:
Live Password:
Workspace [l save) paz sword|injmy.Mac 05| keychain
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3. From the pop-up menu, choose Connect to a SharePoint site.

An input form appears, as shown in Figure 2-4.

4. In the Address text box, enter the URL of your SharePoint site.
You should get this information from your IT department or Help Desk.
5. In the Authentication text box, click this pop-up menu.

Choose one of the following two options based upon instructions
provided by your IT department or Help Desk:

¢ Username and Password

¢ Kerberos
6. In the User Name text box, enter your SharePoint username.
7. In the Password text box, enter your SharePoint password.
8. (Optional) Save your password in Mac OS Keychain.

Click the Save Password in My Mac OS Keychain checkbox if you want
your Mac to remember your login information so you have to enter your
username and password each time you connect to this server.

9. Click the Connect button.

Document Connection displays the available folders in your SharePoint
server.

Working with files

Working with folders and files involves a combination of the Document
Connection application and your Safari or FireFox Web browser. Our examples
and figures were made using Windows Live Workspace. If you are using
SharePoint, you will use the SharePoint Web site to do the same things.
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Adding Workspaces (Folders)

Workspaces contain files that you can share. Folders are called Workspaces
in your Windows Live Workspace. Microsoft suggests creating a new
Workspace (Folder) for each of your projects. Use your Web browser to
create folders. Do the following to create a folder on the server:

1. Open Safari or Firefox Web browser.

2. Navigate to the Windows Live Workspace URL or to your SharePoint

server URL.

3. Sign into the Web site.

Figure 2-5 shows the beta Windows Live Workspace interface that
displays when you sign in. SharePoint offers a similar interface.

List of workspaces New Delete Toolbar
Document list | Add Documents| Shared Share Sign Out
al H I_ James
1.0ffice Live Wogkspace Sign Out
¥ Workspaces A My Wofkspaces »
Documents DDC uments
@oic []new v [l Add Documents X A & share ~
& HR Docs Demo ;
O/  Name B —odified Modified by Size (KB)
Workspace 2 &
o : : :
& New Workspace [ ] Book 6 Chapter 1 January 08 11:26 AM goldkey74@hotmail.com 1290
Ehara i “ O ] Locked April 06 10:38 PM goldkey74@hotmail.com 58
Documents
eleted Items Use the Documents workspace to store your individual documents. To be more efficient, create workspaces for each project.
Follow these easy steps:
=
% ?
L ] o)
O b o
STEP 1: STEP 2: STEP 3:
F| ure 2-5 ffice Live Small Business Create separate workspaces Add documents you Share your workspace so
g . for each of your projects. want to store and share. friends and colleagues can
. Need help with view or edit its contents.
Adding a P wit
Workspace?
. Tap the wisdom of the \ . .
lee Workspace Communi Watch video Watch video Watch video
Workspace
location. L = i
© 4009 Microsoft Qorporation. All rights reserved. | Accessibility | Support | Legal | Privacy Language + | @ Help | Community Feedlljack
New Workspace Language | Send feedback
Workspace Community Help

Workspaces being shared with you Step-by-step instructions with video
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4. Create a Workspace (Folder) by taking one of the following two
actions to display the Create a New Workspace dialog as shown in
Figure 2-6:

¢ Click New Workspace in the list of workspaces in the left portion of
the Web browser window. (See Figure 2-5.)

¢ Click the green Create a Workspace Now button in Step 1 of the step-
by-step instructions in the Web browser. (See Figure 2-5.)

Create a new workspace

j Blank workspace
Get started right away.

Class Workspace
Improve your grades using a contact list, date list, class notes, essay outline, and syllabus.

Essay Workspace
@ Manage your term paper or thesis with a term paper outline, thesis template, milestone list,
and more.

Figure 2-6: .
E t Work:

The Create L PI‘;:na su:ce:s‘f’:[c:vent with an invitation, flyer, agenda, attendee list, to-do list, and more.
a NeW #™4, Household Workspace i
Workspace LB | Share a to-do list, contact list, grocery list, and more with family members or housemates.
dlalog - Job Search Workspace

&£ &J Oroanize vour job search using an interview schedule. oreparation notes. cover letter.

5. Choose Blank workspace to create an empty workspace.

Your new Workspace appears in the list of workspaces to the left.

<P Workspaces appears as folders in Document Connection.

Try one of the pre-configured workspaces if you see one of interest.

Adding files

You can add files to a workspace using Document Connection or your Web
browser. Document connection displays the following types of files:

4+ Word, Excel, and PowerPoint (both old style and XML format)

4+ PDF files

4+ Web pages (htm and .html)
In the Web browser interface (see Figure 2-5), you can click the New button

to add additional kinds of files to your workspaces, but these are visible only
in your Web browser, not in Document Connection.
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Adding files with Document Connection

There are several ways to add files to a workspace in Document Connection.
We'll show you three of them.

Method 1

1. Choose a SharePoint or Workspaces connection (see Figure 2-1).

The list of workspaces appears as folders (see Figure 2-7).
2. In Finder, drag a file (or multiple files) into one of the workspaces

(folders).

Your document will be added to the highlighted workspace as shown
in Figure 2-7.

List of connections  List of workspaces
800 Docutent Connection =
g' e U8 A ool il gl e »
Add Location Refresh New File Add File Edit Read Upload Check Out Check In Discard
FILES [« T =] [workspate.office.Jive.com
[ Drahs FileName | a[Size Date Modified Modified By
& Favorite Files U :_;“v bLC -
-[SHAREI‘OINT s
WORKSPACES 'LJ_’\; Documents -
[ R — (5] R Docs Demo _
. | =] Workspace 2 =
Figure 2-7: E
Add|ng a U;“\ Workspace 3 -
fletoa
workspace.
v - (= ) v
Adding a file
Method 2

1. Choose a SharePoint or Workspaces connection (see Figure 2-1).

The list of workspaces appears as folders (see Figure 2-7).

2. Double-click the folder icon next to the name of a workspace.

The files currently in the workspace display.

3. In Finder, drag a file (or multiple files) into the file list.

Your files will be added to the file list.
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Method 3

1. Choose a SharePoint or Workspaces connection (see Figure 2-1).
The list of workspaces appears as folders (see Figure 2-7).

2. Double-click the folder icon next to the name of a workspace.
The files currently in the workspace display.

3. Click the Add File button on the Document Connection toolbar.
The Upload new Files dialog displays.

4. Select the File or Files you wish to add, then click the Upload
button.

Your files will be added to the file list.
You can use the Spotlight search field in the Upload New Files dialog to help
you find files on an Office Live Workspace server. Document Connection can

display up to 4,000 file names.

Adding files using your Web browser

To add files to a workspace using a Web browser:

1. Sign into Office Live Workspace.

2. Choose a workspace in the list of workspaces (see Figure 2-5).
The document list for that workspace displays.

3. Click the Add Documents button.

The Open dialog displays.

Select a file or files.

5. Click the Open button.

Your files will be added to your document list.

=

You can use the Spotlight search field in the Open dialog to help locate files
on a SharePoint server.

Renaming a workspace
To rename a workspace, use your Web browser.

1. Choose a workspace from list of workspaces (see Figure 2-5).

The document list appears.
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2. Click on the name of the workspace at the top of the list.
The name will become an editable field.
3. Type a new name, and then click outside of the field.

The new name displays.

Sharing workspaces

The most important aspect of Document Connection, Office Live Workspace,
and SharePoint is the ability for you to allow others to share your files.
Managing whom you share with is done in your Web browser. To share

a workspace, you create an invitation and send it to the e-mail addresses

of those who will be allowed to share your workspace. (See Figure 2-8.)
Recipients can be one of two types:

4+ Editors: Editors are allowed to view, download, open, modify, and
upload new versions of documents in the workspace.

4+ Viewers: Viewers can only view documents in the workspace.

To access your workspace, invitees will need to sign into Office Live
Workspace using the e-mail address that the invitation was sent to. The role
of the invitee is determined by which e-mail address field you use when
creating the invitations. Instructions for using a Web browser to access your
Office Live Workspace are included in the invitation.

The following steps show how to create and send an invitation using Office
Live Workspace on the Web. A similar procedure is used to invite SharePoint
users to a SharePoint workspace.
1. Choose a workspace from list of workspaces (refer to Figure 2-5).
The document list appears.
2. Click the Share button shown in the margin.

The Share your workspace dialog opens as shown in Figure 2-8. You can
also click the green Share this Workspace now button.

3. In the Editors text box, add the e-mail addresses of your invitees.
Separate multiple recipients with commas.

You can choose Editors and Reviewers from your Microsoft Messenger
contacts by clicking the little button to the left of the field where you put
the e-mail addresses.

4. In the Viewers text box, add e-mail addresses. Separate multiple
recipients with commas.

5. In the Message text box, type a message that will be included with the
invitation.
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Sharing option Comment Editors
Workspace to share | Messenger contacts Share | Activity log
[l oo James
3.0ffice Live Workspace Sig] out

My Workspaces A My Wrkspaces »
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& 1R Docs Demo

Workspace 3|
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Workspace 2

Share your worksga
Workspace 3
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% New Workspace

1] [Type or select e-mail addresses
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Documents Viewers:
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B =G

Share  Comment Activity

Message: (Optiond))
L fiet everyone view this without signing in g
(0 Send me o copy of the sharing nvitaion
Office Live Small Business
— [ New ~ [ Add Documents X Delete % Cut H3 Copy &
See how to:
Figure 2-8: - O [  nName Modified Modified by Size (KB) i
T =} =] Alumni authors 31 minutes ago @® fnail.com 1
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™ ] Essay Outline 2 hours ago @ fnail.com 65 4
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© > 4»
Workspace' © 2009 Microsoft Corporation | All rights reserved. | Accessibility | Support | Legal | Privacy Languade = | @@ Help | Community | Feedback
= data from mic 112207 et _ 7
Toolbar Send invites Document list

Invitation message

Viewers

6. (Optional) Check the Let Everyone View This Without Signing In check
box to allow invitees to preview the workspace without logging in.

Editors will still have to sign in to use editing privileges.

7. (Optional) Check the Send Me a Copy of the Sharing Invitation
checkbox if you’d like a copy of the invitation sent to you.

8. Click the Send button to send the sharing invitations to the invitees.

Figure 2-5.

Viewing files

When an invitee signs into Office Live Workspace, the shared workspaces
will appear under the Shared with Me heading in the list of workspaces. See

To view a file in the Web browser, simply position the mouse over a file and
wait a moment. A pop-up menu will appear. (See Figure 2-9.)
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| New

4k Add Doct

ments  /

4+ Edit Profile: Displays a form that lets you update your Office Live

documents right in your Web browser. When in View mode you can

e Edit: Opens the document on your computer using the appropriate

e Save As: Downloads the file to your computer using your Web

e Version: Lets you add and remove versions of the file. See Figure 2-10.

O L]  Name Book 3 Chapter 3_GB rev by JG.doc
Figure 2-9: [ ®] 0305 Making a H Ei:;;zt: (389 KB}
Inviting O ®] Book 3 Chagti  [Edit profile]
others to O ] Book 6 Chapter: | (o
share a O B TOA_Current Open in Microsoft Office Word
Rename
workspace.
Add documents to your workspace and share it with others.
Choose one of these options:
Workspace personal information.
4+ View: Displays your document in a viewing mode. You can view
choose from the following additional options:
application.
browser.
— Ee
: . g P é
Flgur_e 2-10' Version Share » Comment Activity
Keep|ng ]. minute age by T
track Of flle Save to version history
VerSionS Delete all versions

| dsAdd & new document version.

¢ Share: Displays the Share a Workspace dialog (discussed earlier in
this chapter).

e Comment: Lets you type a comment regarding this file. If you have
one or more previous comments about the file, this button displays
those comments.

e Activity: Displays a pane that contains a log of the activity regarding

the file.

4+ Open in [application]: Opens the file on your computer in the appropriate
application.

4 Rename: Displays the document in View mode and selects the name so
that you can type a new name.
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Editing

To edit a file using Document Connection:

1. Choose a workspace from list of workspaces (see Figure 2-5).
The document list appears.

2. Select a document from the document list.

3. Click the Edit button on the Document Connection toolbar.

Document Connection downloads the file and opens it in the appropriate
application.

Downloaded files are stored in the Document Connection cache. When you
are done editing, use File>Save As so that you can choose a location you
can remember. You’'ll need to know where your edited file is before you can
upload it to the server.

Right-click or Control-click on a file name to display a pop-up menu with
additional options, including choosing which application to use for editing
or opening read-only. If a file doesn’t open automatically, double-click the
file name in the Document Connection File list.

Reading

Clicking the Read button when you have a file selected downloads the file to
your computer and then opens the file as read-only. To open a file as read-only:

1. Choose a workspace from list of workspaces (see Figure 2-5).
The document list appears.

2. Select a document from the document list.

3. Click the Read button on the Document Connection toolbar.

Document connection downloads the file and opens it in the appropriate
application as read-only.

Uploading

When you’re done editing a document, click the Upload button on the
Document Connection toolbar (see Figure 2-1) to display a file browser that
lets you choose your file in Finder so that you can upload it. The Upload
button works only with SharePoint. Use the Add button to upload an edited
file to an Office Live Workspace.

Checking out

To indicate you have checked out a file, click the Check Out button on the
Document Connection toolbar (see Figure 2-1). The Check Out feature is
available only when using a SharePoint server.
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Checking in

To indicate you have checked in a file, click the Check In button on the
Document Connection toolbar (see Figure 2-1). The Check In feature is
available only when using a SharePoint server.

Drafts

The files that you are currently editing from a SharePoint server are listed in
the Drafts section of the Navigation Pane.

Adding favorite files

Drag a file from any server folder to Favorites in the Navigation Pane to save
the file’s location as a favorite.

Discarding

The Discard button removes your name from the Checked Out By column.
This feature applies only to files located on a SharePoint server.

Deleting files

Document Connection is unable to delete files. Instead, use the Web
browser. To delete a file, select a file in the file list, then click the Delete
button on the toolbar in the Web browser, as shown in Figure 2-5.

Empty cache

Document connection stores downloaded files in a cache location. Every
once in a while you should empty this cache in order to free up disc space.
To empty the Document Connection cache:
1. From the Document Connection menu, choose Preferences.
The Document Connection Preferences window displays.

2. Next to the Clean Office Document Cache label, click the Delete
Cached Files button.

The button will change to a deactivated state. The button will not be
active if the cache is empty.

3. Close the Preferences window.
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Motion Path Animations in PowerPoint

Figure 2-11:
The Custom
Animation
tab.

Once you apply the SP2 update to Office 2008, your copy of PowerPoint will
become equipped with new animation capabilities. We discuss PowerPoint
animation in Book IV, Chapter 7 where you learn that PowerPoint 2008
provides three animation types:

4+ Entry Animations

4+ Emphasis Animations

4+ Exit Animations

Once the SP2 update is applied, you'll find a new animation type called
Path Animations. These are the same as the Motion Path animation types in
Windows versions of PowerPoint.

To add a path animation to any slide object in PowerPoint 2008, follow these
steps:

1. Select any slide object such as a shape, picture, text, and so on that
you want to animate with a path animation.

2. In the Toolbox, choose the Custom Animation tab. You can also bring
up this tab using the View=>Toolbox/Custom Animation option.

You will see the Custom Animation tab as shown in Figure 2-11.

000 Custem Animation Q
o RS-

L - (B) adderfec: | F, 30, 9 .ZJ L
N
k ) Animation order:

\; Curve

(%, Freeform
o - ’ ‘B Scribble

T

Start On Click

Property
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3. Select the Add Path Animation (the fourth button on the top row) to
reveal a popup menu (refer to Figure 2-11).

4. You can choose your path for the animation to be any of the following
four options:

e Line: Draws a straight line from one point to another.

¢ Curve: Draws a curve using points in between the starting and
ending points.

¢ Freeform: Draws a freeform style line that lets you draw both lines
and curves.

e Scribble: Draws a scribble just like you would draw with a pencil on
paper!

All four path types are created in the same way as the line drawing
options you use across all programs in Microsoft Office 2008, as
explained in Book 1, Chapter 5.

5. Add any of the four path types explained the previous step,
PowerPoint adds both a green and red arrow end to the path.

The green arrow end signifies the starting point of the path animation
while the red arrow end denotes its end point.

Right-click or Control-click on a path line to produce a pop-up menu. Choose
Edit Points for more control over how the points on your line behave. With
motion path lines, you can use all of the line-editing features described in
Book I, Chapter 5.



